
Although I have used the example of image files in this tutorial these 

techniques can be applied to any data file such as word processor, spreadsheet or 

database files. 

 



 

 

     Fig. 18.8  

 

There are two ways of selecting a number of files.  If the files are consecutive, 

then left click the first file then hold down Shift while left clicking on the last file and 

all the intervening files will become selected. To select random files, hold down Ctrl 

while left clicking on the files individually. 

 

In the example above, the various images have been selected at random. To 

rename them all in a single operation, use F2 or right click on one of the selected 

images, then type in the new name such as ‘Swimming’ and press the Enter key. This 

will rename the five selected files as ‘Swimming’, ‘Swimming (1)’ through to 

‘Swimming (4)’ and make any future searches so much easier. 

 



suggest that you create a new folder within your ‘My 

Pictures’ folder called something like ‘To be 

Allocated’ and then download the photos from your 

camera to that folder. With the downloading 

complete, open up the ‘To be Allocated’ folder and 

choose Thumbnails from the View drop down menu. 

(Fig. 18.7). 

Fig. 18.7 

This will show small copies of the images which can now be descriptively named. 

Select a file by left clicking on its thumbnail image when it can be re-named in a 

number of different ways but I would suggest either -  

1. Choose Rename from the File drop down menu. 

2. Press the F2 function key or 

3. Right click on the file and chose Rename 

Using any of the alternatives listed above, the original file name will be highlighted 

and replaced by your choice of name as soon as you start typing. Obviously this is 

going to be a tedious process if you have to rename each file individually but, as 

usual, there is a way to speed things up dramatically by renaming multiple files. 

  

Selecting multiple files: 

 



The same degree of understatement should be employed with the Effects tab but the 

Sharpen tool often works a treat to lift a picture off the screen. All changes made to an 

image are reversible in the opposite order in which they were created.  

By this time you should be having a lot of fun and you can always go ‘Back to 

Library’ to try your hand on other pictures or cancel the effects when you have made 

a right mess of the selected photo. 

 

Picasa uses a unique method of saving any editing changes you make to a picture in 

that it does not alter the original file.  It simply remembers the changes you make so 

that you can reverse those changes at a later date should you choose to do so. If want 

to make the changes permanent, choose Save As from the File menu and give the new 

image a different name such as ‘Moggy improved’. 

Re-naming and cataloguing images: 

 

Files should be named in such a way that they can be retrieved easily. The original 

file name is normally used when it is saved for the first time. A letter to your 

electricity supplier, created by a word processing program, could be named simply 

‘Letter 47’ but it would take a long frustrating search to retrieve it three months later. 

On the other hand it would only take an instant to find the file if it had been named 

‘Ripoff Electric Sept 2007’ 

 

Unfortunately digital cameras do not yet possess the ability to give descriptive names 

to images and they are allocated names such as P276893 or DSC0003491. Such file 

names make it very difficult to find that lovely photograph of Freddie on his 5th 

birthday hence the need to rename these images with descriptive wording. I would 



Flash lights, especially those mounted close to the lens, often produce the dreaded 

demonic redeye effect by reflecting the flash from the blood vessels at the back of the 

eye. The Redeye tool removes this unnatural effect thus rescuing what would 

otherwise be a wasted image. Simply drag a small square around the eye in question 

and the red eye blemish is removed. 

 

I’m Feeling Lucky is a lucky dip of a tool where the program tries to improve the 

picture as it thinks it should be. You win some and lose some with this tool. 

 

Both Auto Contrast and Auto Colour are much more controllable that the ‘Lucky’ tool 

and will often enhance your photos to competition levels while the Fill Light tool 

alters the brightness of the image. 

 

The Tuning tabs: 

 

These offer further lighting controls that are more subtle than the Fill Light facility. 

You can alter the emphasis on the highlights and shadows of an image by using the 

sliders or automatically by using one or both of the automated buttons. Be gentle with 

your tuning or you may land up with something that failed to get into the Tate Modern 

gallery. 

 

The Effects Tab: 

 



 

To view an individual image in greater detail double click on it and Picasa enters its 

Edit mode. 

 

Edit Mode:  

 

   

The Edit (Fig. 18.6) mode offers three 

tabs for Basic Fixes, Tuning and Effects 

. With the aid of these simple tools you 

can improve a photo out of all 

recognition or create a weird and 

wonderful picture that bears little 

relationship to the original picture. 

 

Basic Fixes: 

 
Fig. 18.6 

The Crop tool allows you to trim the picture to standard sizes or a random size of your 

choosing by dragging the cursor across the image to produce a rectangular selection. 

 

The Straighten tool repairs those pictures that you had failed to line up correctly at the 

time of snapping the scene. 

  



 

Proper cataloguing can be rather time consuming because, while Picasa can store 

images in folders and albums, each file ought to be given a descriptive name. Picasa 

allows you to do this by selecting a file by clicking on it then go to File on the menu 

bar and choose Rename and replace the camera’s choice of file name – something 

useless such as DSC2849003 – with a descriptive name. Multiple files can be 

renamed at one go by following the instructions later in this chapter. Once you have 

renamed most of your photos the Search bar really comes into its own. For instance 

you may have a number of photos of your pet cat spread across various folders which 

would make life difficult if you just wanted to see the cat pictures. Let us say that you 

have renamed these various files with the cat’s name – Moggy. Simply type the word 

“Moggy” into the Search bar and every photo you have ever named with Moggy in 

the file name will be displayed in a flash. 

 

As I said you need have no worries about moving the thumbnails about from folders 

to the albums – they will stay within their original folders – but beware of 

deleting images from folders because you will delete them from your hard disk. This 

may not be a bad idea because we tend to keep even the most disastrous images for 

some vague reason that they ‘might come in useful’. Bad images never ‘come in 

useful’. On the other hand Picasa allows you to mark your best pictures with a star so 

that you can display these pictures at the touch of a button. You will find the star 

button just to the left of the Rotation buttons. Select the image and click the button. 

 

You can have as many albums as you like and you can enter the same image into 

several different albums without fear of messing up your filing system completely. 



8. The Rotation tools and 

9. The additional tools.  

 

Some of your photos may have been taken in portrait mode and will be lying on their 

side. Select one of them by clicking on it and then rotate the image using one of the 

Rotation tool buttons. Once you have corrected all the rotated pictures select them all 

by using CTRL+A then click on Slide Show on the upper tool bar. The program than 

shows all the selected pictures in full screen view as, would you believe, a slide show. 

 

Cataloguing the images: 

Picasa’s great strength is in its cataloguing ability. As we have seen, it will retrieve 

images scattered across your hard disk and list their folders on the left hand side. By 

clicking on a folder the large pane will display the images within that folder. Many 

people simply place all their pictures into the main Pictures folder which, inevitably, 

grows to an unmanageable size. Better file management would be to create various 

sub-folders of Pictures and allocate images to descriptive locations such as Cornwall 

trip 2007, Jane’s wedding or grandchildren. Picasa allows you to do this in a different 

way – by creating albums. At the top of the left hand folder column you will notice 

four buttons beside the word Library. The first of these allows you to create your own 

albums. Simply click on the button, name the album folder and start dragging images 

from the main window onto the new album at the top of the folder column. You are 

not moving the images from one folder to an album but simply telling the album 

where to find the chosen pictures. Once you have dragged the thumbnails to the 

album you can then click on the album name to display the contents in the same way 

as you did when clicking on a folder. 



 

 

Fig. 18.5 

 

Study this window quite carefully because I shall be referring to it quite frequently. 

Identify the following elements of the window –  

 

1. The Menu Bar 

2. The Tool Bar 

3. The Search Bar 

4. The list of folders 

5. The Thumbnails 

6. The Scroll Bar 

7. The selected image 



 

So what have you done? You have basically copied the image files from the camera’s 

memory card onto your computer’s hard disk. The images remain on your camera 

card until you choose to delete them in the knowledge that you have copies safely 

stored on your computer. We can now start to make some alterations to them and this 

is where Picasa comes in as a very good, free, cataloguing and simple manipulating 

tool.  

 

Picasa: 

Open up the program from the desktop by double clicking on its icon – and wait. Not 

only will the program load up but it will start to whiz through your hard disk to find 

any image files that are lurking there. Do not be surprised to find that there are several 

images listed that you knew nothing about, these may be sample pictures or other 

images loaded by other programs. It does this automatically so give it a bit of time. 

Eventually you will see a list of folders down the left hand side with thumbnail 

images of your pictures in the main part of the window as in Fig. 18.5. 

 



           

If all you see is a long list of files then click on the View option and 

choose thumbnails or icons. 

7. At this stage I would normally select only those images that I want to keep on 

the computer but, for this exercise, I want to select all of the pictures and 

transfer them from the card to the computer’s hard disk. Clicking CTRL+A 

will achieve this. I will deal with the selection of groups of files a little later. 

8. Having selected all the image files using CTRL+A, use CTRL+C to copy 

them into the computer’s temporary memory. Now we have to create a place 

to store these pictures so click on the Start button. 

9. Choose the Pictures folder; click on Organise and then choose New Folder. 

Give it a descriptive name such as “Freddie’s 3rd birthday” (without using the 

quotes) and double click on it to open the empty folder. 

10. Now use CTRL+V to ‘paste’ the files from the temporary memory onto the 

hard disk to achieve your mission. Success? Flippin’ marvellous! 

 

Windows XP 

 

Windows XP actually makes file transfer rather easier than Vista in that, having 

selecting the images as in Step 7, the right hand panel offers various useful 

alternatives such as Moving and Copying files without having to use the CTRL+C 

and CTRL+V method. You simply tell the computer to copy the files then navigate to 

My Pictures, create a new folder and then choose paste files from the right hand 

column of options. 



loading process which is something I do not want to happen at this stage so 

close any Elements windows and you should find a screen as in Fig. 18.3 

displayed. I am only interested in the General option of Opening the folder to 

view the files so we need to click on this option. If you have any 

problem with this you can always go to My Computer and double click on the 

card reader icon.   .                                                                         

    

5. The first window will display a single folder called something like DCIM so 

open this by double clicking on it when you will find further files labelled 

OLY40S or 100ND70 or some other unfathomable description. Double click 

on one of these files and, if you are one of those ‘born lucky’ types, you may 

see a list of files or thumbnail images. If not go back and double click the 

other folder. 

6.     Fig. 18.4     

           



1. The computer should be up and running when carrying out this procedure. 

2. Push the card reader’s 

plug into the correct 

socket (Fig. 18.2) These 

plugs are invariably USB 

(Universal Serial Bus – if 

you really want to know!) 

plugs with a characteristic                             

Fig. 18.2         shape that can only go into a particular USB socket. You should 

have at least three of these sockets somewhere on your machine but, if in 

doubt, call upon the services of your guardian angel to guide you and the plug 

in the right direction. The computer will usually recognise the addition of this 

extra item of equipment and accept its presence or the card reader may come 

with its own program disk. 

3. Remove the storage card from the camera and insert it into one of the card 

reader slots. It will only go one way into one of the slots available. I would 

expect to see a small light to show on the card reader when the correct 

connection is made.   

4. Now leave things alone and let the computer do its work. Caution: If 

you have already installed 

Photoshop Elements© this 

Fig. 18.3  

  program 

will open and take over the 



If you have the pictures on a CD then it is easy to insert the disk into the drive and 

load them up as we did in Chapter 16. If not 

then we have a little more work to do. Each 

digital camera has a storage card of some 

description that such as Compact Flash, Smart 

Media, XD Card or  

Fig. 18.1 memory stick depending on the manufacturer. Do not bother yourself 

with the technical differences between these card formats just accept the fact that they 

all do the same job of storing your images. Again most cameras come with a cable to 

link the camera to the computer but these can be fiddly to work with especially if the 

cable is short and the socket is at the back of the computer. The easier solution is to 

get a card reader (Fig. 18.1) which can ‘read’ all the differing formats for less than 

£20. 

 

Transferring images from the camera card to the computer: 

 

Windows Vista 

There are only minor differences between the two systems in this exercise so 

Windows XP users should read through this process and the minor exceptions 

will be explained at the end. This process is certainly something you could try on your 

own. There is very little that you can break and the only result of failure is that you 

cannot transfer your images. However it might help if you had your guardian angel on 

hand to sort out any unforeseen problems. 

 



Chapter 18 – Basic Photo Manipulation 

  

Skills needed: Knowledge of files and folders (Chapter 4) 

Equipment needed: A digital camera, the Picasa program, photographic paper 

and, preferably, a digital card reader. 

 

Digital camera use has grown out of all recognition in the past few years and, while 

they have major advantages over the old film format, they are not without their 

drawbacks. We take many more photos with these cameras in the knowledge that we 

are not committing ourselves to the cost of film and developing and we get the  

satisfaction of seeing the images immediately. Nevertheless snapshots viewed on a 

tiny display of the back of a camera are no substitute for the printed image that we can 

hand round to friends and relatives. These disadvantages arise because, while the 

majority of us can take instant photos, we are less confident in transferring the best 

images to our computers and display them in an attractive way. 

 

This is where Picasa, the program we have just downloaded, comes into its own. I am 

assuming that you have taken a number of pictures on your camera and that you want 

to transfer them to your computer. You may have taken the card to one of the high 

street photographic outlets such as Boots, Tescos or Jessops and had them transferred 

to a CD. Whatever your situation we need to get these image files into the computer 

for manipulation, cataloguing and storage. 

 


